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CORPORATE PROFILE
Micromeritics Instrument Corporation is the world’s leading supplier of high-performance systems
to characterize particles, powders and porous materials with a focus on physical properties,
chemical activity, and flow properties. Our technology portfolio includes: pycnometry, adsorption,
dynamic chemisorption, particle size and shape, intrusion porosimetry, powder rheology, and
activity testing of catalysts. The company has R&D and manufacturing sites in the USA, UK, and
Spain, and direct sales and service operations throughout the Americas, Europe, and Asia.
Micromeritics systems are the instruments-of-choice in more than 10,000 laboratories of the
world’s most innovative companies, prestigious government, and academic institutions. Our
world-class scientists and responsive support teams enable customer success by applying
Micromeritics technology to the most demanding applications. For more information, please visit
www.Micromeritics.com.
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Contact Us

CONTACT US
Micromeritics Instrument Corporation
4356 Communications Drive
Norcross, GA / USA / 30093-2901
Phone: 1-770-662-3636
Fax: 1-770-662-3696
www.Micromeritics.com
Instrument Service or Repair
Phone: 1-770-662-3666
International — contact your local distributor or call 1-770-662-3666
Service.Helpdesk@Micromeritics.com
Micromeritics Learning Center
Phone: 1-770-662-3607
www.Micro.edu
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ERROR MESSAGES
If using a keypad, see Error Messages for Keypad Installations on page 32.

If the Action response indicates to contact a Micromeritics service representative, record the error
message, then make backup copies of any files involved in the operation.
2430

Error accessing file [n], error code = [n].

Cause A: Media may be damaged.
Action A: Clean the media drive. If this does not eliminate the problem, attempt operation
using a backup copy of the file.
Cause B: Hard disk may be damaged.
Action B: Contact your Micromeritics Service Representative.
Cause C: An application error occurred when the file was accessed.
Action C: Contact your Micromeritics Service Representative.
Cause D: The file name specified contains one or more invalid characters.
Action D: Enter a valid file name. Do not use characters such as * or ?. Refer to the operating
system manual.
2431

Error writing file [n], error code = [n].

Cause A: User logged onto a computer that does not have Write permissions.
Action A: Contact your IT department to change user permissions.
Cause B: Insufficient hard disk space to perform the operation.
Action B: Copy files not used regularly to an external media. Delete them from the hard disk,
and then try the operation again.
2432

Invalid response from MMI ‘FILE_READ’ request.

Cause: An internal processing and/or hardware error has occurred.
Action: Contact a Micromeritics service representative if this error message continues.

2433

New entries have been found in this directory. Refresh the directory information?

Cause: Several analyzer files have been added to this directory by some function other
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than the analysis application.
Action: Click Yes to update the directory information with data from each new file. This
operation may take a minute.
Click No to locate the file manually. This option may be feasible if a large number of
files have been copied into the directory and the file name is known.
2434

File [n] — Subset [n] wrote wrong [n] bytes, expected [n] bytes.

Cause: An internal processing and/or hardware error has occurred.
Action: Contact your Micromeritics Service Representative.
2436

Path specification [n] is invalid.

Cause: An invalid path name and/or extension was entered.
Action: Enter a valid path name (including the proper extension), then press Enter.
2437

File name [n] does not exist.

Cause: The file selected in the report option does not exist.
Action: Enter an existing file specification, or select a file name from the list box.
2439

Cannot register file.

2440

Subset not found.

2441

Seek within file failed.

2442

Bad header in subset file.

2443

Subset owner denied access.

2444

Not a valid file format.

2445

Subset wrote the wrong amount of data.

2446

Error reading data.

2447

Error writing data.

Cause: An unexpected error occurred when trying to access a data file.
Action: Contact your Micromeritics Service Representative.
2448

File directory [n] is invalid. Resetting to the installation directory.

Cause: A working directory specified in the .INI file is invalid, has been moved or deleted.
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Action: The installation directory will be substituted. The next time a file is opened, use the
directories list to move to the correct directory.
2449

This field does not contain a valid file specification.

Cause: An invalid file name was entered.
Action: See the description of file naming conventions in a Windows manual, then re-enter
the name.
2456

Insufficient file handles available. Application cannot continue.

Cause: More than 50 files are open at the same time.
Action: Refer to a Windows operating system manual then set the limit for open files to 50
or greater. Alternatively, close any unused open files.

2458

An instrument is performing a critical operation. Wait a few moments before
exiting the application.

Cause: An attempt was made to exit the application while the analyzer was performing a
critical operation. This operation must be completed before the application can be
exited.
Action: Wait a short time and attempt to exit the application again.

2459

An instrument is busy. A delay in restarting this application could result in loss
of new data. Continue with program Exit?

Cause: An attempt was made to exit the application while an analysis was in progress.
While this is possible, the data collected when the application is inactive will not be
permanently recorded until the application is restarted. A power failure to the analyzer could cause some data to be lost. Continued data collection may also exhaust
the memory of the controller.
Action: If not concerned with the potential for loss of data should a power failure occur, click
Yes to continue; otherwise, click No.
2460

Fatal Communications error on [n].

Cause: There was a fatal error in communication between the application and the software
in the analyzer. All displays for that analyzer will be closed.
Action: Ensure that the analyzer is connected to the computer on the communications port
configured in the Setup program. Stop and restart the analyzer application. Contact
your Micromeritics Service Representative.
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2461

No instruments are in operation. This application will unconditionally terminate.

Cause: At least one analyzer must be active for the application to operate. The initialization
of all analyzers configured with the Setup program has failed. The application
stops.
Action A: Usually this message is preceded by another message giving the reason for the
analyzer ’s failure to initialize. Refer to the instructions for that message.
Action B: Ensure that the analyzer is attached to the computer on the communications port
configured with the Setup program. Verify that the analyzers power switch is in the
ON position and that the light on the front panel is illuminated. Contact a Micromeritics service representative if this error message continues.
2477

[n] did not properly initialize.

Cause: The application was unable to initialize this analyzer. This is usually caused by one
of the conditions listed in the previous error messages.
Action:

n

n

n
n

2480

Correct the problem indicated in the previous error message, then restart the
application.
Run the Setup program and ensure that a valid port is specified; if not, specify a
valid one when prompted.
Reinstall the application, then restart the application.
Contact a Micromeritics service representative if this error message continues.

File [n] cannot be analyzed. It is currently being edited.

Cause: An attempt was made to start an analysis using a file that is open for editing.
Action: Finish editing the file, save and close it, then start the analysis.
2481

Error accessing the sample information file [n].

Cause A: An unexplained error prevented access to this file.
Action A: The hard disk drive may be corrupt. Run computer diagnostics.
Cause B: An attempt was made open a file that is already open, possibly minimized.
Action B: View the minimized icons, locate and maximize the file.
Cause C: A computer or network problem occurred.
Action C: Check the performance of the computer devices or network.
2482

File cannot be opened for writing.

Cause: An attempt was made to open a file currently being used.
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Action: Locate the application using the file. In the Micromeritics application, use the Window menu item for a list of all open windows.

2483

An analysis cannot be performed on [n]. It is open for editing and contains
errors.

Cause: An attempt was made to use a sample file containing errors that is currently open.
Action: Go to the window containing the file, correct the errors, then save it.

2484

The edit session for [n] must be saved before the analysis. Save changes and
continue with the analysis?

Cause: An attempt was made to start an analysis using a file that contains unsaved
changes and is open for editing.
Action: Click Yes to save the changes, then proceed with the analysis. Click No to cancel
the analysis, then continue editing the sample file.
2486

Cannot construct [n] report type. Program will terminate.

2487

Cannot start report generator. Error code [n]. Program will terminate.

Cause A: Full rights to the application folders and files is required.
Action A: Contact a system administrator to have full rights granted.
Cause B: An internal processing and/or hardware error has occurred.
Action B: Contact your Micromeritics Service Representative.
2488

File [n] cannot be opened. It is already in use.

2488

File [n] cannot be opened for editing.

Cause: The specified file is open for editing.
Action: Check the Window menu item to locate the other edit session or check if the file is
open in another application.
2489

File [n] cannot be opened for writing.

Cause A: The specified file in a Save As operation is open.
Action A: Select a different file for the Save As operation.
Cause B: The specified file is set to read-only.
Action B: Right-click the file, select Properties and change the read-only setting.
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2490

No ‘.INI’ file present. Program will terminate.

Cause: The ASCII .INI file containing initialization information and system options information used during program startup does not exist.
Action: Restore the .INI file from back-up or re-install the application.
2491

Highlighted fields contain errors. Please correct the errors before closing.

Cause: The fields highlighted in red contain invalid entries. The window cannot be closed
until all errors are corrected.
Action: Check the entries, correct the errors, then close the window.
2492

This field’s entry is invalid.

2493

An entry is required for this field.

Cause: The highlighted field contains an invalid entry.
Action: Check the entry and correct the error.
2494

Value is out of the valid range.

2495

Enter a value between [n] and [n].

Cause: The entered value in the highlighted field is outside the valid range of values.
Action: Check the entry, then either enter or select an appropriate value. The valid range is
shown in the information bar.
2496

Invalid number.

2497

This field contains an invalid character.

Cause: An invalid number (or character) was entered in the highlighted field.
Action: Check the entry, then either enter or select a valid number (or character).
2499

Sequence number must contain at least 3 digits.

Cause: An attempt was made to enter a sequence number that did not contain at least
three digits.
Action: Enter a sequence number that contains at least three digits.

2500

6

All sample file names that can be created using the sequence number pattern
already exist. You may want to modify the next sequence number.
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Cause: No more sample files can be created using the currently entered file name
sequence number.
Action: Go to Options > Default Method, then enter another sequence number.
2505

Error logger cannot be initialized. Error code [n]. Program will terminate.

Cause: An internal processing and/or hardware error has occurred.
Action: Contact your Micromeritics Service Representative.
2506

Sample file [n] has a No Analysis status and cannot be used for this operation.

Cause: The selected sample file does not have collected data and cannot be used for operations, for example, reporting.
Action: Enter the name of a file with a status of Complete, Analyzing, or Entered. Alternatively, select a sample file from the list box.
2508

Overlay [n] was not found. It will not be included in the reports.

Cause: The specified overlay file could not be found.
Action: Ensure the file specified as an overlay exists.
2509

Error opening file [n]. Reports cannot be produced.

Cause: An error occurred while the application was opening a file necessary to the report
operation.
Action: Use the name given in the error message to investigate. Contact your Micromeritics
Service Representative.
2510

Error parsing reports from file [n]. Reports cannot be produced.

Cause A: One or more data entry fields in the sample file may contain an invalid character.
Action A: Review the data entry fields, then remove the invalid character.
Cause B: The system was unable to create the usual temporary files during the report, possibly due to insufficient disk space.
Action B: Check the available hard disk space .
Cause C: An internal processing error occurred.
Action C: Contact your Micromeritics Service Representative.
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2511

Print job [n] has been canceled due to insufficient disk space. Delete unnecessary files and restart the report.

Cause: The media drive does not have required space for the temporary file.
Action: Delete unnecessary files from the disk. At least five megabytes of free space is
required for normal operation.
2512

Print job [n] canceled.

Cause: The print job was canceled by the operator.
Action: None required.
2513

Unable to read the calibration file [n].

Cause: An invalid calibration file was selected or cannot be read.
Action: Ensure the media containing the calibration file has no problems.
2514

Unable to write the calibration file [n].

Cause: An attempt to save calibration data has failed due to possible media problems.
Action: Ensure the destination location has no problems or select an alternate media to
save the calibration data.

2515

Warning: Changing the calibration information will affect the performance of the
instrument. Only qualified service personnel should do this. Do you wish to proceed?

Cause: The process of performing a calibration operation was started.
Action: Calibration operations should only be done by or under the direction of qualified service personnel.

2516

Warning: Keeping a backup copy of the calibration data is recommended by
Micromeritics. Would you like to do so now?

Cause: A calibration operation was performed and a backup copy is recommended.
Action: Save the calibration data to a file.

2517

Canceling this dialog will reset the calibration state to what it was when this dialog was first opened. Are you sure you want to cancel?

Cause: The calibration has not been accepted upon the completion of the calibration oper-
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ation.
Action: If the calibration operation was successful, click Accept.
2520

No data points available for reporting.

Cause: The selected sample file does not have collected data and cannot be used for
reporting.
Action: Select a different sample file.
2522

Invalid controller application file.

Cause: The application’s control file has been corrupted or deleted.
Action: Reinstall the analysis program.
2532

The instrument contains a different software version. Do you want to reset it?

Cause: The application has discovered a different version of application operating in the
analyzer.
Action: If there are no analyzers other than the one connected to the computer, click Yes,
then allow the updated application to load.
2584

The application encountered an unexpected error and will be halted.

Cause: Unknown error caused application termination.
Action: Restart application, re-install application or contact your Micromeritics service representative.
2533

Analyzer initialization failed.

Cause: An internal processing and/or hardware error has occurred.
Action: Contact your Micromeritics Service Representative.

2585

Please re-install to make use of Windows libraries for file management. The following libraries are missing: [n]

Cause: This message is triggered on application start up if any of the library files used by an
application do not exist on disk.
Action: Add the library into the libraries folder.
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2599

The selected file has an extension that is not supported by this operation.

Cause: The selected file does not have a supported file extension.
Action: Open the adsorptive properties file. Open the .FPI file selector and select another
file with a supported file extension.
2610

Failed to create directory [n].

Cause: Bad permissions for selected directory.
Action: Ensure that permissions on the parent directory of the selected folder match the permissions of the installation directory. If they do, contact your Micromeritics service
representative.
2611

Browsing outside of the configured location is not allowed.

Cause: File browsing is limited to the application directory and custom repository location if
one was specified during installation.
Action: Restrict file browsing to the allowed locations. No user should be able to browse outside the installation directory or custom repository location when using the application.
2612

File [n] cannot be created by [n]. It is a restricted file type.

2613

File [n] cannot be modified by [n]. It is a restricted file type.

Cause: Confirm Analyst accounts cannot open, create, or modify parameter files.
Action: Use a Confirm Developer account to open, create, or modify parameter files.

2614

File [n] cannot be modified by [n]. An error in the audit trail occurred. Changes
cannot be saved.

Cause: The Confirm sample audit trail could not be written, preventing changes to the
sample file.
Action: Contact your Micromeritics Service Representative.

2615

[n] cannot belong to both the analyst and developer group in order to run this
application. Program will terminate.

Cause: The user attempting to log on to the Confirm application cannot be a member of
both the Confirm developer group and the Confirm analyst group.
Action: In Windows Users and Groups, verify that the user does not belong to both groups.

10

Error Messages - 2390 Gemini VII
— May 2021

Error Messages

2616

[n] must belong to the analyst or developer group in order to run this application. Program will terminate.

Cause: The user attempting to log on to the Confirm application must be a member of either
the Confirm developer group or the Confirm analyst group.
Action: In Windows Users and Groups, verify that the user belongs to one of the groups.
2617

[n] has been locked out. Please contact your system administrator.

Cause: The user has attempted to log in to the Confirm application too many times and the
user account has been locked.
Action: Contact your system administrator to unlock the user account.

2618

Application will be terminated due to an error [n] during a password update for
[n]. Please contact the system administrator to change the password manually.

2619

Failed to automatically update password for [n]. Please contact the system
administrator to change the password manually.

Cause: An unsuccessful attempt was made to update the password for the specified user.
Action: Contact the system administrator to change the password manually in Windows
Users and Groups.

2620

Too many environment variables in use. Reduce the number of Windows environment variables.

Cause: An attempt was made to use too many Windows environment variables.
Action: Ensure the total number of characters in the Windows environment does not
exceed 5120 characters.

2621

Large environment variables found. Remove any environment variables exceeding 2048 characters.

Cause: Environment variables are too large.
Action: Ensure there are no long environment variables.
2622

Critical error [n] encountered. The application may not work as expected.

Cause: An attempt was made to run the Confirm application in a Windows environment
other than Windows 10 Professional or Windows 10 Enterprise or higher.
Action: Run the Confirm application in a Windows 10 Professional or Windows 10 Enterprise or higher environment only. If you are already running the required operating
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system, contact your Micromeritics service representative.

2623

Application will be terminated due to an error [n] in acquiring a windows cryptographic context.

Cause: An attempt was made to acquire a Windows cryptographic context and the process
failed.
Action: Contact your Micromeritics Service Representative.

2624

Application will be terminated due to an error [n] in generating a random password.

Cause: The Confirm application failed to generate a random password for the specified
user.
Action: Manually create a password in Windows Users and Groups.

2625

Application will be terminated due to an error [n] in acquiring a windows cryptographic service context.

Cause: An attempt was made to acquire a Windows cryptographic service context and the
process failed.
Action: Contact your Micromeritics Service Representative.
2626

Could not retrieve logged in username or domain.

Cause: The installation process failed.
Action: Reinstall the Confirm application by using the default installer options. Contact a
Micromeritics service representative if this error message continues.
2628

Incorrect password for [n].

Cause: An incorrect password was entered when an attempt was made to start an analysis.
Action: Re-enter the correct password.

2629

The application controller [n] must not belong to either the analyst or developer
group in order to run this application. Program will terminate.

Cause: The application controller was placed in the analyst or developer group (or both).
Action: Remove the application controller from the group(s).

12

Error Messages - 2390 Gemini VII
— May 2021

Error Messages

2630

Failed to get user account information [n].

2631

Failed to acquire credentials handle [n].

2632

Failed to initialize security context [n].

2633

Failed to complete authorizing token [n].

2634

Unsupported operation to authorize token [n].

2635

Failed to accept security context [n].

Cause: Refer to the error code provided.
Action: Contact your Micromeritics Service Representative.
2636

Cannot log in as a guest.

Cause: Guest account was used as a login.
Action: Use a valid user account that’s not a guest account.
2637

Application will be terminated due to an error [n] in decryption.

2638

Error handling new user credentials [n].

2639

Error handling password expiration [n].

Cause: Refer to the error code provided.
Action: Contact your Micromeritics Service Representative.
2640

Timeout error [n].

Cause: Refer to the error code provided.
Action: Contact your Micromeritics Service Representative.

2644

Application will be terminated due to an error [n] in initializing the controller process.

Cause: Refer to the error code provided.
Action: Contact your Micromeritics Service Representative.
4003

Error obtaining relative pressures. Check Po setting.

4004

Error computing quantity adsorbed.

Cause: An internal processing and/or hardware error occurred during report generation.
Action: Contact your Micromeritics Service Representative.
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4005

Pressures were not smoothed. Not enough pressures below 0.10 [n].

Cause: The Smooth pressures below 0.10 P/P0 option was selected on the Report Options
window. There must be at least 10 pressures within this range for smoothing to
occur.
Action: Deselect this option to disable this message.
4006

Report type not found.

4007

Error processing report.

Cause: An internal processing and / or hardware error occurred during report generation.
Action: Contact a Micromeritics service representative if this error message continues.
4008

Report requested on sample file with no data points.

Cause: The selected file contains no collected data.
Action: Select another file which contains collective data and restart the report.
4014

File [n] is not a valid file for conversion.

Cause: The file selected for conversion is not a valid file.
Action: Select only files that have been created by the proper program.

4023

The file [n] cannot be prepared for analysis. It is open for editing and contains
errors.

Cause: An attempt was made to start an analysis using a file that contains errors and is
open for editing.
Action: Finish editing this file, save and close it, then start the analysis.
4026

Cannot calculate Dubinin-Astakhov: bad least squares data.

Cause: Less than two selected data points are within the fitted pressure range.
Action: Edit the selection of data points on the Dubinin interactive editor or on the Dubinin
Pressures window.
4027

Fewer than two sample files have data suitable for heat of adsorption reports.

Cause: Less than two of the selected sample files for heat of adsorption reports contain
appropriate data.
Action: Edit the Quantity Adsorbed table, or select other sample files.
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4028

Dubinin calculations cannot be performed because the affinity coefficient of the
analysis gas is zero.

Cause: Dubinin values could not be calculated because the affinity coefficient of the analysis gas is zero.
Action: Access the Dubinin Report Adsorptive options in the sample file, then enter an
appropriate value for the analysis gas.
4029

At least two fitted data points are needed for Alpha-S calculations.

Cause: Fewer than two data points fall within the selected Alpha-s range.
Action: Edit either the calculation pressure in the fitted Alpha-s range, or use a different
reference curve.
4030

Preparations failed in primary data.

Cause: Appropriate data were not available to generate the report.
Action: This message was preceded by a different error message. Refer to the cause/action of the preceding message.
4031

Not enough points with a relative pressure in the range [n].

Cause: Fewer than two data points selected for the Dubinin report fall within the selected
relative pressure range.
Action: Edit the calculation pressure range or the fitted relative pressure range.
4033

Not enough points to generate Dubinin Tabular Report.

Cause: There are fewer than two valid data points available for the Dubinin tabular reports.
Action: At least two micropore pressures must be selected for inclusion in the Dubinin
report. Edit the selection of data points on the Dubinin interactive editor or on the
Dubinin Pressures window.
4034

Fewer than 2 points available for Dubinin calculations.

Cause: There are fewer than two valid data points available for Dubinin reports in one of the
sample files selected for overlaying.
Action: At least two micropore pressures must be selected for inclusion in the Dubinin
report. Edit the selection of data points on the Dubinin interactive editor or on the
Dubinin Pressures window.
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4035

Cannot calculate optimized Astakhov exponent.

Cause: There are fewer than two valid data points in the relative pressure range specified.
Astakhov reports will not be produced.
Action: At least two pressures must be selected for inclusion in the Astakhov report. Edit
the selection of data points on the Astakhov interactive editor or on the Astakhov
Pressures window.
4036

Fewer than 2 points available for Horvath-Kawazoe calculations.

Cause: At least two data points must be selected for inclusion in the Horvath-Kawazoe analysis. No report will be produced.
Action: Edit the selection of points on the Horvath-Kawazoe interactive editor or on the Horvath-Kawazoe window.

4037

Computations failed while processing the primary data set. No reports will be
produced.

Cause: The preparation of data for reporting could not be successfully completed. No Horvath-Kawazoe reports will be produced. This message will always be preceded with
another one containing additional information.
Action: Refer to the error message number which preceded this one for an explanation.
4038

Fewer than 2 points available for the Langmuir Qm computation.

Cause: The Cheng/Yang correction to the Horvath-Kawazoe equation requires the value of
the monolayer volume as calculated from the Langmuir equation. The isotherm
must include at least two points above 0.02 relative pressure for the Langmuir equation to be applied.
Action: The analysis will be performed without the Cheng/Yang correction. Deselect Apply
Cheng/Yang correction on the Horvath-Kawazoe Report Options window to prevent this message from appearing on future reports.
4039

The isotherm does not meet the constraints of the Cheng/Yang assumption.

Cause: The Cheng/Yang correction to the Horvath-Kawazoe equation requires the value of
the monolayer volume as calculated from the Langmuir equation. The isotherm
does not correlate to the Langmuir assumption with a coefficient of 0.98 or more.
The correction is not applicable to this isotherm or to the range of the data points
selected.
Action A: The analysis will be performed without the Cheng/Yang correction. Deselect Apply
Cheng/Yang correction on the Horvath-Kawazoe Report Options window to pre-

16

Error Messages - 2390 Gemini VII
— May 2021

Error Messages

vent this message from appearing on future reports.
Action B: Generate the Langmuir report for the same data points selected for the HorvathKawazoe report. If the Langmuir correlation coefficient can be brought above 0.98
by removing some points at high relative pressure, remove them, then reproduce
the Horvath-Kawazoe reports.
4040

The value of Qm computed from the Langmuir equation is too low.

Cause: The Cheng/Yang correction to the Horvath-Kawazoe equation requires the value of
the monolayer volume as calculated from the Langmuir equation. The computed
value is less than the volume adsorbed at the largest relative pressure included in
the analysis. The correction is not applicable to this isotherm or to the range of the
data points selected.
Action: The analysis will be performed and the Cheng/Yang correction will be applied to all
points with a volume adsorbed less than the value of Vm. The pore size will not be
calculated for data points with an invalid volume adsorbed. Deselect Apply
Cheng/Yang correction on the Horvath-Kawazoe Report Options window to clear
this message.
4041

The Cheng-Yang correction is inappropriate for some [n].

Cause: The Cheng/Yang correction is usually inappropriate for any P/P0 above the isotherm knee. In some instances, the computed pore sizes may decrease above the
knee. While it is possible to include these relative pressures (usually above 0.1
P/P0) in the analysis, the computed pore sizes for these pressures are usually
meaningless.
Action: Change the data points selected for the Horvath-Kawazoe report to include only relative pressures at or below the knee of the isotherm, or change the HorvathKawazoe report options so that the Cheng/Yang correction is not applied.

4042

0.0 cannot be a starting or ending pressure for a geometric progression from
low pressure.

4043

1.0 cannot be a starting or ending pressure for a geometric progression toward
saturation.

Cause: An attempt was made to generate a pressure table from a geometrically
progressing range.
Action: Change the specified entered value.
4044

Points in the Langmuir report pressure table lie outside the collected data.
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4045

Points in the report pressure table lie outside the collected data.

Cause: Calculation pressure range is not being used. More than one of the report pressure
table points is above the range of the collected data and more than one is below.
Action: Change the report pressure table to be more consistent with the collected data.
4046

[n] could not be opened for reading.

Cause: A thickness curve file could not be opened.
Action: If the problem persists, restart the computer, then optionally perform a media integrity check.
4047

Warning: An error occurred while reading [n].

Cause: An error happened during a read operation of a thickness curve file.
Action: If the problem persists, restart the computer, then optionally perform a media integrity check.
4048

Warning: An error occurred while restoring the heat of adsorption report editor.

Cause: The state of the heat of adsorption report editor could not be restored. Default settings will be used.
Action: No action.

4049

The sample [n] does not have enough data. A minimum of two adsorption
points is required.

Cause: A sample file has been included in the Heat of Adsorption report that does not have
enough data.
Action: Remove the file from the selected file list.

4050

None of the requested quantities adsorbed is within the range of the collected
data of more than one sample file.

Cause: The Heat of Adsorption report failed because the specified quantities are not within
the range of the collected data.
Action: Edit the quantities adsorbed so that they are within the range of the collected data,
or select other sample files.

4051
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The sample [n] does not have any data in the range of the requested quantities
adsorbed.
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Cause: The sample data cannot be interpolated to any of the quantities adsorbed.
Action: Edit the quantities adsorbed so that they are within the range of the collected data.
4052

Fewer than two points are selected for this report.

4052

Fewer than three points provided to the interpolation table.

4052

Fewer than three points are selected for this report.

Cause: At least two (or three) points are required for the BET calculations.
Action: Edit the calculation range in the BET report.
4053

At least two data points must be selected for t-Plot calculations.

Cause: At least two points are required for the t-Plot calculations.
Action: Edit the calculation range for the t-Plot report.
4054

Fewer than two data points are inside the fitted thickness range.

Cause: At least two points must be within the fitted thickness range for the t-Plot calculations.
Action A: Edit the calculation range for the t-Plot report.
Action B: Edit the fitted thickness range in the t-Plot report editor.
4055

A positive BET surface area was not calculated. Please check your BET Report.

4056

A positive Langmuir surface area was not calculated. Please check your Langmuir report.

Cause: Fewer than two points were assigned to the requested surface area calculation in
the collected data table.
Action A: Assign more points to the surface area calculation.
Action B: Select a different surface area in the t-Plot report editor.
4057

At least two data points are needed for Freundlich calculations.

4058

At least two data points are needed for Temkin calculations.

Cause: Less than two data points have been selected for the specified report; at least two
are required.
Action: Edit the selection of points on the report's interactive editor or on the Pressures window for the specified report.
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4059

Fewer than 2 points available for MP-Method calculations.

Cause: At least two points are required for the MP-Method calculations.
Action: Edit the calculation range for the MP-Method report.
4060

Sample [n] contains no data points.

Cause: An attempt was made to save a sample without collected data as a t-curve or alphaS curve.
Action: Repeat the Save As t-curve or Save As alpha-S operation after opening a sample
that has collected data.
4061

The t-curve must contain at least 2 points.

Cause: At least two points are required in a thickness curve definition.
Action: Edit the thickness curve.
4062

Error during report preparation.

Cause: An internal processing error has occurred.
Action: Contact your Micromeritics Service Representative.
4063

The data requested on this report are not available. No subreports selected.

Cause: There is no information in the sample log to report.
Action: A sample file was selected of which no analyzer operations were used. Select a
sample file with a status of Prepared, Preparing, Analyzing, or Complete to obtain a
valid sample log report.
4067

No data points are within the range of pressures in the reference isotherm.

Cause: There are no collected data points within the range of pressures in the reference isotherm.
Action: Select data points in the range of the reference isotherm, or select a more appropriate reference isotherm.
4068

No points were selected for the f-Ratio report.

Cause: The f-Ratio-report does not have any points selected.
Action: Edit the selection of data points on the f-Ratio window.

20

Error Messages - 2390 Gemini VII
— May 2021

Error Messages

4070

Unable to load deconvolution model [n].

Cause: The list of available models was corrupted; therefore, the model selected could not
be loaded for the deconvolution.
Action: Exit the application. Reinstall the application, then try again.
4071

The selected pressures points do not form a valid set for deconvolution.

Cause: The data points selected for analysis do not contain enough information to allow a
DFT data reduction.
Action: At least two points with strictly increasing pressures and volumes adsorbed are
required for a DFT Plus data reduction. Edit the selection of data points on the DFT
interactive editor or on the DFT Pressures window.
4072

The range of pressures selected is too small to deconvolute using this model.

Cause: A null result was found using the selected model.
Action: At least two points with strictly increasing pressures and volumes adsorbed are
required for a DFT Plus data reduction. Edit the selection of data points on the DFT
interactive editor or on the DFT Pressures window.
4073

The analysis gas [n] does not match the model gas [n].

Cause: The model assumes a specific gas, and the sample file uses a different one.
Action: Select a model that assumes the same gas.
4074

The analysis temperature [n] does not match the model temperature [n].

Cause: The temperature for the selected model did not match the analysis temperature.
Action: Select a different model.
4075

The models cannot be located in the models folder. Reinstall the software.

Cause: The models could not be located. They may have been inadvertently deleted or
moved.
Action: Reinstall the application.
4077

Cannot get surface area for [n].

Cause: The Isotherm report for the named overlay file has Per gram selected for the
Volume Adsorbed, and the Isotherm report for the primary file has a surface area

Error Messages - 2390 Gemini VII
— May 2021

21

Error Messages

option selected for the Volume Adsorbed.
Action A: Edit the Isotherm report for the named overlay file, then select a surface area option
for Volume Adsorbed.
Action B: Click Overlays on the Report Options window of the primary file, then remove the
named overlay file from the list.
4078

Slope and Y-Intercept cannot be determined from the selected points.

Cause: The Langmuir report cannot be generated from the selected points.
Action: Edit the calculation pressure range in the Langmuir report pressure window.
4135

HOA file [n] does not exist.

Cause: The sample file in the Heat of Adsorption report list does not exist.
Action: Go to Report > Heat of Adsorption. Click Add Samples, then select the sample
file.
4136

HOA file [n] is corrupt.

Cause: The sample file in the Heat of Adsorption report list is corrupt.
Action: Go to Report > Heat of Adsorption. Select the corrupt sample file, then click
Remove Sample. Rerun the Heat of Adsorption report.

4400

The computer does not have the communications port specified for the
SmartPrep(s). Cannot initialize.

Cause: The communications port associated with this unit was not valid.
Action: Run the setup program and set up the unit on a valid port.

4401

The communications port specified for the SmartPrep(s) is already in use. Cannot initialize.

Cause: The communications port associated with this analyzer is in use by some other program in the system.
Action: Close the other program to release the port. Restart the analysis application.

4402

The communications port specified for the SmartPrep(s) cannot be accessed.
Cannot initialize.

4403

Cannot communicate with SmartPrep Unit [n].
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Cause: The communications port associated with this unit was not valid.
Action: Run the setup program and set up the unit on a valid port.
4404

The application version of the SmartPrep Unit [n] is invalid.

Cause: The controller application running on the designated analyzer is invalid.
Action: Use the SmartPrep setup program to download the proper controller application to
the analyzer, or if unavailable, contact a Micromeritics service representative.
4405

Fatal communications error with SmartPrep Units[n].

Cause: There was a fatal error in the serial communications between the application and
the SmartPrep Instrument Controller. All displays for that SmartPrep will be closed.
Action: Ensure that the SmartPrep is properly chained to the computer on the communications port configured in the Setup program. Stop and restart the application.
Contact a Micromeritics service representative if this error message continues.
4407

Error searching for installed Smart VacPreps. The registry could not be read.

Cause: The application was not installed properly.
Action: Reinstall the application. Contact a Micromeritics service representative if this error
message continues.

4408

The [n] in [n] already has Smart VacPrep S/N [n]. The Smart VacPrep must be
removed from the [n] before it can be added.

Cause: The Smart VacPrep was already installed for another application / unit.
Action: Remove the Smart VacPrep from the installed unit before adding it to the preferred
unit.
4409

A free IP address on the same subnet as [n] could not be found.

Cause: All IP addresses on the network for the Ethernet card specified during installation
are in use by other Micromeritics applications on this computer.
Action A: Uninstall unused Micromeritics applications.
Action B: Configure a different Ethernet card for use by the application using the application
installer.
4410

The .INI file could not be updated with configuration for Smart VacPrep S/N [n].
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Cause: The application .INI file is opened by another application and could not be updated.
Action: Close all open applications and add the Smart VacPrep again using the Smart
VacPrep menu.
4411

Error dosing.

Cause: The backfill timed out.
Action: Ensure there is gas available and the pressure regulator is set to the appropriate
pressure. Also ensure that the gas supply regulator shutoff valve is open.
4412

Error calibrating the servo.

Cause: Calibration results are out of range.
Action: Follow standard calibration procedures and try again. Contact a Micromeritics service representative if this error message continues.
4413

Error overheating on port [n]. Current = [n], Target = [n], Limit = [n].

Cause: The temperature of the indicated mantle exceeded the maximum allowed value.
Action: Ensure the power and thermocouple connectors for the mantle are properly
installed. Contact a Micromeritics service representative if this error message continues.
4414

Error thermocouple unplugged on port [n]. Target = [n].

Cause: The thermocouple is unplugged or has malfunctioned.
Action: Ensure the thermocouple is plugged in. Contact a Micromeritics service representative if this error message continues.

4415

Degas transducer zero calibration failed. Current Offset = [n] counts, Current
Pressure = [n], New Offset = [n] counts, Nominal = [n] counts.

Cause: The pressure transducer offset exceeds the recommended limit.
Action: Ensure that the vacuum pump is on. Repeat the pressure offset calibration. Contact
a Micromeritics service representative if this error message continues.

4416

Degas transducer scale calibration failed. Reference = [n], Current = [n], New
Scale = [n] /count, Nominal = [n] /count.

4417

Degas vacuum gauge low point calibration failed. Reference = [n], Current = [n].
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Cause: The transducer offset calibration was rejected.
Action: Contact your Micromeritics Service Representative.
4419

Error reading servo DAC.

Cause: The servo valve target could not be set. All degas operations have been canceled.
Action: Contact your Micromeritics Service Representative.
4420

Communications error.

Cause: The application failed to connect to the Smart VacPrep.
Action: Ensure the unit is powered and properly connected to the network specified during
installation. Check the power cable, power switch, and Ethernet cable, then reconnect to the Smart VacPrep either through the Smart VacPrep menu for this analyzer
or by restarting the application. Contact a Micromeritics service representative if
this error message continues.
4421

Smart VacPrep S/N [n] is busy and could not be removed.

Cause: The Smart VacPrep cannot be removed because it is currently performing an operation.
Action: Wait until the Smart VacPrep completes the current operation and try again.
4422

The file [n] does not exist.

Cause: The selected file does not exist on the media drive.
Action: Select an existing file. Ensure that the file has been created before use.
4423

The sample [n] is already selected on port [n].

Cause: The selected sample file is already selected for use on a different port.
Action: Select another sample file for this port.

4424

The file [n] on port [n] could not be opened. Check if the sample file is already
in use for editing or analysis.

Cause: The selected sample file is already open by this or another application.
Action A: The selected sample file is damaged.
Action B: Select another sample file.
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4425

The sample [n] on port [n] has an invalid status and cannot be used for degassing.

Cause: The status of the file is not consistent with the current operation.
Action: Select a sample file that has not been used for an analysis. Only sample files with a
status of No Analysis or Prepared may be selected.
4426

Port [n] is currently in use. Operation cannot be started.

Cause: The current operation cannot be completed because the port is already in use.
Action: Wait for port to terminate operation or perform the desired operation on an unused
port.

6000

An error occurred while loading the application control information. Data entry
cannot be performed. (Code [n]).

Cause: An error occurred accessing the control information disk file required by this application.
Action: The disk drive may have failed or be corrupt. Run diagnostics on the disk drive.
6008

At least one sample must be selected to proceed.

Cause: An attempt was made to start an analysis without selecting any sample files.
Action: Select at least one file, then start the analysis.

6023

Desorption points in this sample file cannot be processed by this instrument.
Continue with adsorption points?

Cause: The selected sample file in this analysis has desorption points selected in the pressure table. The analyzer (Gemini 2390a or 2390p) cannot report desorption data.
Action A: Click Yes to continue with the analysis and report adsorption data only. Click No
either to select a different file or to edit the current file.
Action B: If using a Gemini 2390t, select Start Analysis for that unit.
6024

Some selected reports are invalid for this instrument.

Cause: The requested report cannot be generated with the Gemini 2390a.
Action: Edit the report selections on the Report Options window.
6025

26

Serial write queue full.
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Cause: There was a fatal error in communication between the analyzer and the application.
All displays for that analyzer will be closed.
Action: Ensure the Ethernet cable is securely connected. Exit the application and then
restart it. Contact a Micromeritics service representative if this error message continues.

6026

Measure Po for each point is not supported by this model. Choose another
sample file for analysis or change the Po option in the analysis conditions.

Cause: Measure Po for each point was selected as the saturation method. This option is
only available for the Gemini 2390p or 2390t.
Action: Edit the Po options in the analysis conditions and select Entered or Most recent
measured as the saturation pressure method.
6027

Analysis: Po dosing failure.

Cause: The Dewar does not contain enough cryogen to take an accurate reading in the Po
tube.
Action: Refill the Dewar with cryogen and restart the analysis.
6028

This instrument does not provide measured Po analyses.

Cause: An attempt was made to start an analysis on the Gemini 2390a using a sample file
in which Measure Po for each point was selected as the saturation method. This
feature is available only for the Gemini 2390p and 2390t.
Action A: Cancel the analysis, open the sample file, and select Entered or Most recent measured for the P0 value. Restart the analysis
Action B: Select a different file and continue with the analysis.
Action C: If a Gemini 2390p or 2390t is attached, select Start Analysis for that unit.
6029

Instrument is not completely calibrated.

Cause: The analyzer in use is missing calibrations.
ActionA: Go to Unit > Calibration > Load from File and select a file containing calibration
data. Contact a Micromeritics service representative if this error message continues.
6030

A sample must be selected to proceed.

Cause: Select a sample file prior to starting a blank analysis or a QuickStart analysis.
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Action: Select a sample file and proceed with the analysis.
6031

Cannot read the analysis conditions parameter file.

6032

Cannot read the adsorptive properties parameter file.

6033

Cannot read the report options parameter file.

Cause: The file is corrupt.
Action: Recreate the file or select a different file.
6035

The instrument e [n]. is not calibrated.

Cause: Upon initialization, the analyzer was unable to locate the calibration file.
Action: Go to Unit > Calibration > Load from File and select a file containing calibration
data. Contact a Micromeritics service representative if this error message continues.
6036

Pressure is out of range.

Cause: There is a problem with the analyzer’s calibration.
Action: Select Unit > Calibration > Load from File, then select a file containing calibration data. Contact a Micromeritics service representative if this error message
continues.
6037

Sample pressure underrange.

Cause: A test of the sample pressure transducer showed a low reading. The current operation will continue.
Action: Contact a Micromeritics service representative if this error message continues.
6038

Sample pressure overrange.

Cause A: Adsorbate gas pressure is too high. The current operation will continue.
Action A: Verify that the gas inlet pressure regulator setting does not exceed 15 to 18 psi
(103.4 to 124.1 kPa). Contact your Micromeritics Service Representative.
Cause B: An error occurred in the pressure measurement electronics.
Action B: Contact your Micromeritics Service Representative.
6039

28

Po pressure underrange.
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Cause: A test of the P0 pressure transducer showed a low reading. The current operation
will continue.
Action: Contact your Micromeritics Service Representative.
6040

Po pressure overrange.

Cause: The gas pressure in the P0 tube is too high. The current operation will continue.
Action A: Verify that the gas inlet pressure regulator setting does not exceed 15 to 18 psi
(103.4 to 124.1 kPa). Contact a Micromeritics service representative if this error
message continues.
Cause B: An error occurred in the pressure measurement electronics.
Action B: Contact a Micromeritics service representative if this error message continues.
6041

Quantity adsorbed underrange.

Cause: A test of the quantity adsorbed pressure transducer showed a low reading. The current operation will continue.
Action: Contact a Micromeritics service representative if this error message continues.
6042

Quantity adsorbed overrange.

Cause A: The rate of adsorption by the sample exceeded the response capacity of the analyzer, preventing normal refilling of the gas reservoirs.
Action A: Repeat the analysis using a smaller amount of sample.
Cause B: An error occurred in the pressure measurement electronics.
Action B: Contact a Micromeritics service representative if this error message continues.
6043

Evacuation timeout.

Cause: The analyzer failed to reach a suitable vacuum level within the specified evacuation
time.
Action A: Remove and reattach the sample and balance tubes, ensuring that both are
securely in the port.
Action B: Verify that the vacuum pump is operating properly.
Action C: If actions A and B don’t correct the problem, degas the sample again and repeat the
analysis.
Action D: Contact a Micromeritics service representative if this error message continues.
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6044

Dosing timeout.

Cause A: The adsorbate gas supply was depleted by the analyzer during analysis or termination.
Action A: Verify that the inlet valve on the gas bottle is open and that the gas pressure regulator setting is between 15 and 18 psig (103.4 and 124.1 kPa). Check the
adsorbate gas bottle to see if it is empty; replace if necessary.
Cause B: Sample has adsorbed the maximum amount of gas available.
Action B: If additional data points are required, repeat the analysis with a smaller amount of
sample (to avoid exceeding 100 cm3 STP total volume adsorbed).
6045

Elevator timeout.

Cause: The elevator was unable to reach the raised or lowered position.
Action: Check for obstructions. Contact a Micromeritics service representative if this error
message continues.
6048

Po fill timeout.

Cause: The adsorbate gas supply was depleted during and analysis or a P0 measurement.
Action: Verify that the inlet valve on the gas cylinder is open and that the gas pressure regulator setting is between 15 and 18 psig (103.4 and 124.1 kPa). Verify that the
adsorbate gas is not empty; replace if necessary.
6049

Operator canceled operation.

Cause: Cancel was clicked while an analysis or a Po measurement was in progress.
Action: Restart the operation.
6050

Valve failure.

Cause: An error in the valve control electronics has occurred.
Action: Contact a Micromeritics service representative if this error message continues.
6051

Power fail.

Cause: A power failure occurred during an automatic operation. The operation was canceled.
Action: Restart the operation.
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6052

Zero calibration failed.

6053

Scale calibration failed.

6054

Transducer match failed.

6055

Dosing servo calibration failed.

6056

Balance servo calibration failed.

6057

Quantity adsorbed calibration failed.

Cause A: Calibration was out of the tolerance range.
Action A: Verify the preparatory steps for the calibration were performed properly. For
example, the sample tube may not have been empty.
If all preparatory steps were followed and no other message was displayed, contact
a Micromeritics service representative.
Cause B: One of the steps in the calibration failed. An additional error message is displayed.
Action B: Refer to the Cause/Action for the error message that displayed with this one.
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ERROR MESSAGES FOR KEYPAD INSTALLATIONS
Error messages display in the third and fourth lines of the keypad window at the conclusion of an
operation. An asterisk also displays on the second line.
Press CHOICE to navigate through the messages. Report data are displayed after messages.
Press CLEAR to delete the message. Messages not cleared remain in the queue until the next
analysis is performed.
NN

Number of cycles completed

ZZ

Number of cycles requested

ANLS_ERR:

Dosing timeout

Cause: The adsorbate (or helium) gas supply was depleted by the instrument during analysis or termination.
Action: Verify:
n
n
n

ANLS_ERR:

The adsorbate gas cylinder is not empty
The inlet valve on the gas cylinder is open
The gas pressure regulator setting is between 15 and 18 psig (103.4 and 124.1
kPa)

Elevator timeout

Cause: Elevator did not reach its limit in the expected amount of time.
Action: Ensure there are not obstructions in the path of the elevator. Contact your Micromeritics Service Representative.
ANLS_ERR:

Evacuation timeout

Cause: The analyzer failed to reach a pressure level of 10 mmHg within the specified evacuation time plus three minutes; or, the analyzer failed to reach a pressure level of 5
mmHg within an additional three minutes.
Action: Re-attach the sample and balance tubes. Ensure both are securely in the fitting.
Verify the vacuum pump is operating correctly. If these actions do not correct the
problem, degas the sample again and repeat the analysis. Contact a Micromeritics
service representative if this error message continues.
ANLS_ERR:
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Cause: Operator canceled the current operation.
Action: Restart the operation when appropriate.
ANLS_ERR:

Po fill time-out

Cause A: Adequate pressure in the Po tube could not be reached.
Action A: Confirm that the gas supply is sufficient.
Cause B: The Dewar does not contain enough cryogen to take accurate readings in the Po
tube.
Action B: Refill the Dewar with liquid nitrogen and restart the analysis.
ANLS_ERR:

Pressure overrange

Cause: The sample pressure transducer detected a pressure measurement that is too high
because the liquid nitrogen level in the Dewar is too low or a valve is leaking.
Action: Add liquid nitrogen to the Dewar. Contact a Micromeritics service representative if
this error message continues.
ANLS_ERR:

Pressure Underrange

Cause: A test of the sample pressure transducer was made during evacuation. The test
showed a low reading. The analysis will continue.
Action: Contact your Micromeritics Service Representative.
ANLS_ERR:

Quantity adsorbed underrange

Cause A: The analysis was canceled because the number of quantity adsorbed A/D
counts was too low at the end of equilibration of free space or an analysis point.
Action A: Reduce volume of sample used.
Cause B: The analysis was canceled because the number of volume adsorbed A/D counts
was too low when quantity adsorbed was recorded during a scanning run.
Action B: Reduce volume of sample used.
Cause C: Balance tube is too large.
Action C: Match size of balance tube to that of the sample tube.
ANLS_ERR:

Quantity adsorbed overrange

Cause: The rate of adsorption by the sample exceeded the response capacity of the analyzer, preventing the normal refilling of the gas reservoirs.
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Action: Repeat analysis with a smaller amount of sample in the tube.
DTA_ERR:
Cause:
Action:
DTA_ERR:

Insufficient data

Cause: BET or Langmuir multipoint surface area analysis was requested but fewer than
two data points were selected for surface area calculations.
Action: Return to Review mode and select more points for calculation.
DTA_ERR:

No data to compute

Cause A: An automatic operation was canceled before all necessary data could be collected.
Action A: Restart the automatic operation.
Cause B: All data points have been excluded in Review mode.
Action B: Return to Review mode and include some data points.
Cause C: A report has been requested and no analysis data have been collected or previously collected data have been deleted.
Action C: Perform a sample analysis to collect data.
HW_ERR:

Reset to factory defaults

Cause: The operator pressed . (decimal) during analysis module power-up and initialization. All previously stored data have been deleted and all parameters have
been reset to factory defaults. Stored Setups are not affected.
Action: Reset parameters.
PRT_ERR:

Timeout failed to respond

Cause: The printer took longer than 30 seconds to acknowledge receipt of data from the
analyzer.
Action: Check to ensure the printer is properly connected to the analyzer, is powered on,
has paper, and is on line.
SYS_ERR:
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Power Fail NN/ZZ completed
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Cause: A power failure occurred. When power was restored, the automatic operation was
canceled. The third line displays the number of data points finished.
Action: Restart the automatic operation.
TRN_ERR:

Timeout, failed to respond

Cause: The receiving device took longer than 10 seconds to acknowledge receipt of data
from the analyzer.
Action: Ensure the receiving device is properly connected to the analyzer RS-232 port and
is powered on. Verify that the serial transmission parameters controlling the receiving device correspond with the data transmission parameters specified in the Setup
mode.
USR_ERR:

No data to review

Cause: The operator selected the Review function and no analysis data have been collected or previously collected data have been deleted.
Action: Perform an analysis to create data to review.
USR_ERR:

Out of range

Cause: Entered value is outside the range of values for this prompt.
Action: Enter a value within the acceptable range for this prompt.
USR_ERR:

Venting Po tube

Cause: Excessive pressure detected in the Po tube at the Reload prompt.
Action: Contact a Micromeritics service representative if this error message continues.
Valve failure:

[ENTER] to retry

Cause: Valves failed to respond.
Action: Contact a Micromeritics service representative if this error message continues.
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